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1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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We hope everyone has survived the holidays. Now,
it’s time to start paying on the credit card bills that
you might have ran up buying all those holiday gifts.
With the holidays behind us, it’s time to look forward
to Spring and all the things that go along with it:
Valentine’s Day, Easter, baseball, warmer
temperatures, putting in a garden … well, at least in
the Northern Hemisphere when it comes to the latter
two.

Spring is typically viewed
as an annual time of
renewal. But then, isn’t
change the one constant
we can all count upon?
Nothing remains the same.
Ever. Things evolve, and
PCLinuxOS is also always
evolving to bring us all a
modern, stable operating
system. Version 3.12.x of
the Linux kernel is currently
undergoing testing, and
Texstar is working on
updating the Xorg server to
version 1.12.4 (supposed
to be the latest version that
still supports the fglrx­
legacy video driver).

What’s so ironic is that, as
human beings, we’re most
resistant to change. Yet,
the one thing we can count
on most is that things will
change. We tend to line our
nests and surround ourselves with things that make
us feel comfortable – then get royally irritated when
change finds its way into our comfortable little corner
of the world.

If you were around when PCLinuxOS made the
change from KDE 3.5.10 to KDE 4.2.x, you might
remember the fervor that exploded over the change.
Never mind that the change was inevitable. Never
mind that KDE 3.5.10 was being discontinued, in
favor of the newer 4.x releases. It didn’t have to
make sense. The old and familiar was being tossed
aside, in favor of the newer version. Along with that
newer version came new ways of doing things.

Some of the old ways
didn’t work with the new
version. Plus, there were
new ways to learn to do
common tasks.

With that change a few
years behind us, it’s
sometimes difficult to even
remember what KDE
3.5.10 was actually like
(aside from booting into an
old Live CD from that era).
As reluctant as some were
to make the change, the
change did eventually
happen, even if some
users were reluctant to
embrace that change.
Even the most stalwart
holdout has moved on.

See? The only thing that
we can count on
remaining constant is that
nothing will remain
constant. Things will

change. They always do.

Until next month, I bid you peace, happiness,
serenity and prosperity.

The PCLinuxOS name, logo and colors are the trademark of
Texstar.

The PCLinuxOS Magazine is a monthly online publication
containing PCLinuxOS­related materials. It is published
primarily for members of the PCLinuxOS community. The
magazine staff is comprised of volunteers from the
PCLinuxOS community.

Visit us online at http://www.pclosmag.com
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by loudog

Recently I was faced with a dilemma. You may
empathise with me, possibly having faced similar
circumstances at one time or another. I was happily
computing along, browsing Synaptic for magazine
article ideas when I came across a particularly
interesting looking program that I had not noticed
before.

Hmmmm, this must be new because I doubt my
subconscious would have allowed me to skim past it
without triggering a red flag. I quickly clicked on it to
read the description. Yep, I had found my next
article. Cool. As I selected it for installation my
subconscious now signaled me with the red flag.

Okie dokie, what am I missing here. I scrutinized the
package more closely and soon realized it would
require a substantial amount of the remaining free
space on my root partition. I had already run
bleachbit which netted me only 11.5MB of space,
deleted a number of unneeded packages and old
kernels, gaining another 300MB or so, but I had
already used up most of that. It was time to face the
facts. My root partition was busting at the seams and
in dire need of expansion.

A sinking feeling went through me. If I load the
package, then I may not have enough room for
some future updates, let alone more programs down
the road. Let’s see, what options do I have other
than make a backup, reinstall, reconfigure the
desktop and preferences to my tastes, load and
configure all my extra programs etc, etc.

Ewwww. Not what I wanted to do. Hopefully, next
time I’ll remember OP’s advice and add some extra
room to the default size of the root partition when

installing the OS. I guess I’m paying for that lapse in
judgement now. Well, Boogers.

Hey! That reminds me. There was this prank I have
been planning to pull on my wife (did I mention I’m a
stinker?) I sat and thought about the steps involved
and slowly choreographed the prank in my minds
eye. Yep that should be a good one. Hmmm, this is
not the appropriate place for practical jokes but I
believe the forum sandbox should be okay. Ill post it
there just for fun. And voila! There you have it.

While my conscious mind was distracted,
contemplating my dastardly deed, my subconscious
came up with the solution to my problem. Works
every time. I can use GParted to move my partitions
around and resize them at the same time. Hoop!
There it is!

For the sake of my screenshot program (Shutter)
and to properly illustrate the article, I will be using a
hard drive in an external swap dock that has been
mocked up to look like my original install. This way, I
can load GParted’s GUI from the repository and use
it on the desktop.

Originally I used a Live CD to make these
alterations, but the steps are basically the same.
Backing up your data is the single most
important step to take before starting this
process. You have been officially warned.

When starting GParted on the desktop, you will be
asked for your root credentials. The Live CD version
will not. Looking at the GUI, we see the program first
scanning all disks and their partitions. From the
dropdown menu at the top right, I will select the
mock drive.

Looking at the information provided, I noticed that
GParted says there is 630.10 MiB free on the root
partition. For those of you who don’t know MiB
(mebibyte) is different than MB (megabyte) and can
be a little confusing if different programs report sizes

GParted: Manage Your Partitions
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in differing standards. This gives you a little
homework research if you are so inclined: I was. I
can see dolphin reports size in MiB also. Oops
getting off topic, sorry.

Now, where were we? Oh yes, hey! Now wait just a
cotton­pickin minute here, Dolphin just reported that
I only had 157 MiB free. I guess I’ll take GParted’s
word for it, as it is a partition editing program,
whereas Dolphin is a file manager. I’m, though, a
little confused as to the reason for the size
discrepancy, and a rather large discrepancy at that.
Hmmm, I wonder what Filelight would report?

Anyway, moving on. Even though it appears I may
have half a GiB more room than I first thought, I
believe resizing the root partition is still in my best
interests in the long term. I also think I will expand
my swap partition while I’m at it, which should be
easy enough. The first thing I want to do is decide
how much extra space I will need to swipe from my
home partition.

After deciding on 14 GiB for root and 5 GiB for swap,
I came up with 6GiB needed. First thing to do is
move/shrink the last partition on the drive, “/home” in
this example. Right clicking the last partition, I
unmount it first. Now that the partition is unmounted,
the resize/move option is no longer greyed out.
Selecting the resize/move option, we want to look
closely at the configuration window that is
presented.

Notice my mouse cursor grabbing the left side of the
partition. Thats because we want to create the free
space before /home so we can keep shifting it back
to the swap and root partitions. You can also see I
have created a little more than 5.5 GiB of free space
(free space preceding). Looking at the minimum size
the partition can be shrunk to, we determine that we
have roughly 14 GiB of data on the partition already.
The minimum size requirement is equal to the
existing data on the partition. Since the advent of
super size drives and ssds, I always align my
partitions to MiB, rather than to cylinder. If your drive
was originally aligned to cylinders, I would use that
setting. Next, clicking the resize/move tab triggers a
warning.

Failure to boot is most likely to occur. Quite the
ominous little snippet there. Reading on, we
determine that since this is not the root partition that
contains /boot, I can ignore this. If you have a large
home partition, this will take quite a bit of time as is
stated in the warning. After clicking ok, you will see
something new appear at the bottom of the main
window, the operation scheduler. This gives you an
overview of what exactly it is you have instructed
GParted to do.

We will continue to add operations to the scheduler
until we are done. The next thing to do is move swap
over to the beginning of the /home partition, so I’ll
select it. As the swap partition is grabbed by the

cursor in the middle this time, we can move the
entire thing at once over to the right. Make sure the
“free space following” reads zero. Examine the
space before and after the partition as I move it over.
It’s only partway over at this point. You will also
notice the actual size of the partition is about 4 GiB
(4009 MiB) in the “new size” readout.

Now we simply grab the left end of the partition, like
we did with /home, and expand it to the left until we
see the new size we desire show up in the “new
size” section. We still have 4.8 GiB of free space to
allot to root (free space preceding). Good.

Clicking the resize/move button gives us the same
warning as before and again, not being the root/boot
partition, we ignore it. The swap space
moving/resizing will go very quickly during operation
execution. The modifications are queued into the
operations window, and we move on to our root
partition. Selecting that, we need to unmount it first

GParted: Manage Your Partitions
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then resize. Grabbing the end of the partition in the
same fashion as the others except from the right
side this time, we expand it until the readout for
“freespace following” is zero. Clicking the
resize/move button does not generate an error
message this time because we are not moving the
partition, just expanding it.

In some cases when manually resizing/moving
partitions, the align to MiB option will leave one or
two MiB’s of empty space between them as you can
see in the image. This is normal. After we look over
the operations section and accept that all is well, we
click the apply button. This will bring up the
operations window. In this window all the operations
are mapped out for you to observe in real time.

If we click the details button, we can get a glimpse of
what is really happening in the here and now. With
the expandable menu, many of the menu options
open to reveal sub­menu options so that a precise
and detailed record of what has/is being done and
when, can be scrutinized. I see we have 3hrs
23mins remaining until the first operation is
completed. Wow. It’s a good time to get some lunch
and check back later (center, top).

Ahhh, nothing like a nice relaxing lunch chatting and
laughing with the wife to bring out the sunshine.

Ohhhh, shoot! Nothing like coming back to an error
message to change the forecast to partly cloudy.
Houston, we have a problem.

Although I did not plan on this happening (who
does?), it is a prime example of why we always
make a backup of our data first. Imagine Clint
Eastwood pointing his .44 Mag at your hard drive
and saying “feelin lucky punk.” If you have your
backup, you can look ol’ Clint in the eye and say
“Yes, I am”. Seeing the error message is bad
enough. Why add the “All your data is fubar” to the
mix?

Once, in my early years, I accidentally deleted my
entire /home directory with no backup. I expected

YouCanToo to rub my face in it, as he had warned
me numerous times about data loss and the need to
have regular backups. To my surprise, he was very
sympathetic, leading me to believe that a similar
thing may have befallen him in the past. Data loss is
simply not funny, no matter how you slice it. Just say
“no” to data loss with regular backups. Well, in this
case, it looks like the hard drive is having issues.
After a number of ignores it became apparent that all
was not well so I selected cancel out of curiosity, as I
have never encountered this situation before. That
brought up this window.

Selecting retry, the program restarted the operations
from the beginning. Since I was 104.4 GiB and 2hrs
50 mins into it before the error, I didn’t want to go
through all that again just to encounter another error.
What I wanted to do was check the drives SMART
status. I cancelled the GParted program, opened
Gsmartctl, and was presented with the blood red
hard drive icon that Indicates imminent death. MY,
my, my, I wonder what happened here? The drive
wasn’t that old either, according to the SMART data.

GParted: Manage Your Partitions
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Suddenly, I remembered where it came from. This
drive was removed from a laptop that a motel guest
had owned. One day after becoming totally
frustrated with Windows, he threw the laptop from
the parking lot into the laundry room almost hitting
the maid. Since the maid on duty at the time was my
wife, and he was fairly intoxicated at the time and
primed for a fight, I obliged him. He ended up
beaten, and I ended up with 2 broken ribs and a
broken laptop. Eventually I fixed the laptop by
replacing the hd and returned it to him with
PCLinuxOS in a dual boot configuration. We later
became good friends and he respects PCLinuxOS
for its stability. Nothing like fighting for converts. He
no longer throws his laptop. Realising this drive was
unfit to finish the article with, I quickly dug up
another one and prepared it to take over where we
left off. Now that GParted has finished the
modifications to the drive, let’s look at the operations
window again.

I simply love the detail that GParted gives us in the
report section. You can see that all operations
completed successfully, but with three warnings. The
warnings are flagged with the yellow caution symbol
at the right side of the report. I have the first one
expanded and the warning is that checking is not
available for this type of file system. Hmmm. This is
the swap partition and we all know that swap is a
completely different critter than normal filesystems,
so I’m betting all is fine. The actual hard drive I
originally performed these modifications on is what
I’m using now to write this article. Since it was my
main OS disk, I used GParted’s Live CD ISO, which
you can download from here. In the end, all was
good as the open source community continues to
supply quality software in the modern age.
PCLinuxOS is simply the best!

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

GParted: Manage Your Partitions

mailto:pclinuxos.mag@gmail.com
http://www.linfx.com
http://www.cafepress.com/pclinuxos
http://gparted.sourceforge.net/index.php
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by Paul Arnote (parnote)

The GIF graphic format was, at one time, avoided
like the plague. Compuserve, which created and
patented the one­time popular graphics format,
along with Unisys (who owned the patent of the LZW
compression algorithm that the GIF format
employed), defended their “property” like a hunger­
ravaged junk yard guard dog. As a result,
developers steered away from creating programs
that output GIF files, fearful of being slapped with
cease and desist orders and forced into having to
pay exorbitant licensing fees. Some developers
incited open rebellion against the GIF format, with
such activities as “Burn The GIFs” campaigns. In
fact, there are still some computer users who feel
bitter about the “GIF War” of nearly 20 years ago.

Meanwhile, users tended to shy away from using
GIF files for other reasons. First, standard GIF files
are limited to a 256 color palette. There are other
formats out there that provide a much larger palette
that contributes not only to a much higher color
resolution, but that also appear much more lifelike in
appearance. Second, GIF files – especially
animated GIF files – tend to be relatively large in file
size, especially when compared to the sizes
produced by other graphic file formats.

As a result, the PNG graphics format was created to
help circumvent the patent issues that encumbered
the GIF format. Ironically, Compuserve helped
spearhead the development of the PNG format. The
PNG format offered a larger color palette and
avoided the LZW licensing trap, as well as offering
more options than the original GIF format. Most
importantly, the PNG format was created to be an
open format, free of patents.

Fast forward to today. GIF files are experiencing a
resurgence in popularity, and they can be found all
over the internet. Animated GIF files are now being
used as a replacement for video clips in a lot of
cases, especially on social media sites. The
resurgence can also be partially linked to the fact
that the patents that initially made GIF files taste like
soured milk have now expired in 2003 in the U.S.,
and in 2004 in most of the rest of the world. As a
result, the GIF format can now be freely used
without fear of licensing headaches.

Fortunately, there are a few ways you can create
your own animated GIFs from video files. Most of
these methods involve using the command line, but
their use is relatively simple and straightforward.

Method 1: Free Online Conversion Service

Using the search term “free video to gif conversion”
in Google, you will find over 305,000,000 hits. Wow!
That’s a whole lot of online services (nearly all

serviced by ads that undoubtedly want to track you)
that are lined up to convert your video to an
animated GIF. If nothing else, it’s a testament to how
popular animated GIFs from video files really are.

The requirements may vary from site to site,
however. Some require you to upload the video file
you want to convert. Others require you to provide a
link (e.g., a YouTube video URL) for the video you
want to convert. For what it’s worth, you can use the
youtube­dl command line utility or the Firefox Video
DownloadHelper plugin to download videos from
YouTube (under both utilities) or just about any
streaming video site (in the case of the latter). The
youtube­dl utility is available in the PCLinuxOS
repository, and the Firefox Video DownloadHelper
plugin is available from the Firefox plugins page.

In either case, you will be provided a link to
download your newly created animated GIF file.

Method 2: Using ffmpeg

With ffmpeg (installable from the PCLinuxOS
repository, if you don’t already have it installed), you
have all that you need … well, almost. You’ll use
ffmpeg, followed by the ImageMagick convert
command, to create the animated GIF.

My test file is this YouTube video, which I
downloaded with the Video DownloadHelper plugin. I
chose to excerpt 10 seconds of the video, starting at
the 00:01:28 mark. Here is the command I used
(entered all on one line):

ffmpeg ­i FunnyAmeriquest.flv ­ss 00:01:28
­t 00:00:10 animated­gif2.gif

The ­i FunnyAmeriquest.flv part of the command
specifies the name of the video file I want to use as

View animated version here.

Convert Video Files To Animated GIFs Easily

http://en.wikipedia.org/wiki/File:Newtons_cradle_animation_book_2.gif
http://lmgtfy.com/?q=free+video+to+gif+conversion+online
https://addons.mozilla.org/en-US/firefox/addon/video-downloadhelper/?src=search
https://www.youtube.com/watch?v=QOixDP-SdKw
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the input file. The ­ss 00:01:28 part of the command
tells ffmpeg to start the conversion at that particular
point in the video. The ­t 00:00:10 part of the
command tells ffmpeg that I want to convert the next
10 seconds of video. Finally, the animated­gif2.gif
part of the command tells ffmpeg the filename to use
as the output file.

Now, we could simply stop right there, as we
definitely have an animated GIF file. However, the
file size for that 10 second animated GIF is 6.3 MB.
One way to make a smaller file is to reduce the
frame rate. Add ­r 13 to the command, just before
the output file name, and the frame rate will be
reduced from the typical 24 fps, to 13 fps. Another
way is to resize the output by adding ­s 320x240, for
example, to resize the output image. Again, place
the resize command right before the output file
name.

However, we can get it even smaller, and that is
where using the ImageMagick convert command
comes into play. Enter the following command, all on
one line:

convert ­layers Optimize animated­gif2.gif
ani­gif­opt2.gif

This causes ImageMagick to optimize the GIF file.
The result is a significant reduction in the file size of
the animated GIF. The file size is reduced from a
hefty 6.3 MB, to a much more svelte 3.4 MB.

Below is the final result of my conversion. Readers
of the web version of the magazine will be able to
see the file without any problems. Readers of the
PDF version can download the animated GIF from
here (3.4 MB) and view it in their default web
browser. Reducing the frame rate to 8 fps caused a
further reduction in the file size to 2.1 MB, after the
ImageMagick optimization.

Method 3: Using mplayer

Ffmpeg isn’t the only game in town, when it comes
to managing and manipulating multimedia files. Fans
of mplayer can use their favorite media player to
make the conversion from video to animated GIF.

The command to convert to animated GIF from a
video file is as follows (entered all on one line):

mplayer FunnyAmeriquest.flv ­ao null ­ss
0:01:27 ­vo gif89a:fps=8:output=animated­
gif3.gif ­vf scale=320:240 ­endpos 11

The FunnyAmeriquest.flv part of the command
specifies the input video file to use. The ­ao null part
of the command tells mplayer to forget about
outputting any audio. The ­ss 0:01:27 part of the
command tells mplayer to start at the 1 minute 27
seconds spot in the video. The ­vo
gif89a:fps=8:output=animated­gif3.gif part of the
command tells mplayer to output the image portion
of the video file as an animated GIF, at 8 frames per
second, and to write the output to the animated­
gif3.gif file. The ­vf scale=320:240 part of the
command tells mplayer to rescale the output to 320
x 240 resolution. Finally, the ­endpos 11 part of the
command tells mplayer that the output will be 11
seconds in length.

Below is the result. Readers of the PDF file can click
this link to view the animated GIF in their default
web browser. The file is 2.9 MB.

I skipped using the ImageMagick convert command
on this file. In all of my tests, the optimized version of
the GIF ended up larger than the GIF file output by
mplayer. Perhaps it was my choice of videos, but
who knows. Your mileage may vary. I would
recommend that you try the optimization of the GIF
file with the ImageMagick convert command, then
choose the smaller file, whichever one that may be.

Comparisons & Caveats

There are other methods to create animated GIFs.
One I explored involved installing gimp­gap from the
PCLinuxOS repository. Gimp­gap is designed to
make animated graphics from video files. However, I
found it to be so clunky and unreliable during my
testing that I decided against including it in this
article. It couldn’t even find mplayer, which is
installed on my system. There are also other
programs in the wild world of Linux, such as gifsicle,
but they were excluded because they are not in the
PCLinuxOS repository – and we all know (or should
know) by now how installing items from outside the
official PCLinuxOS repository is frowned upon.

Convert Video Files To Animated GIFs Easily

http://pclosmag.com/Misc-Downloads/ani-gif-opt2.gif
http://pclosmag.com/Misc-Downloads/ani-gif-opt2a.gif
http://pclosmag.com/Misc-Downloads/animated-gif3.gif


PCLinuxOS Magazine Page 10

For whatever reason, the animated GIF files created
with mplayer are bigger than the files produced by
ffmpeg, even when the same frame rate is used.
Notice that in our mplayer example above, the frame
rate has been decreased to 8 fps. The lowered
frame rate makes the animation a bit choppier and
less fluid. But even at this slow frame rate – which is
one­third the normal frame rate – the animation is
still acceptable, albeit barely. The file created with
ffmpeg at the same frame rate of 8 fps – and
subsequently optimized with the ImageMagick
convert command – is only 2.1 MB, still a significant
0.8 MB smaller than the animated GIF file created
with mplayer.

Also, if you look closely at the two animated GIFs,
you will notice that the ffmpeg image is dithered,
while the mplayer image lacks the dithered
appearance. Even with the dithering, ffmpeg
appears to have a quality edge. One video file I was
experimenting with produced a very acceptable
animated GIF with ffmpeg, but the mplayer result
was horrendous. The dithered image produced by
ffmpeg definitely has more forgiveness and latitude
to work with a greater range of video image quality
than mplayer, where the image colors look blocky
and sometimes smeared.

Already, the animated GIF files produced with
ffmpeg have a definite edge when it comes to
producing significantly smaller file sizes. This is
significant, since most sites restrict the size of
animated GIFs to 5 MB or less. Also, be careful, as
it’s very easy to create animated GIF files of VERY
large size.

Of course, the old adage “garbage in, garbage out”
definitely applies when creating animated GIFs from
video files. Starting with higher quality image files
will produce higher quality animated GIF files.
Whenever possible, opt for higher quality MP4 files,
over lower quality FLV files. Also, video files that
utilize higher bitrates are going to inherently be of
higher quality.

Summary

As is usual under Linux, there is more than one way
to accomplish a task. Creating animated GIFs under
Linux is no different. If you think this is complicated,
think again. It’s actually quite easy to create
animated GIFs under Linux. Have fun with this, and
try your hand at creating some animated GIFs of
some of your favorite, short video clips.

Screenshot ShowcaseScreenshot Showcase

The place where breaking news,
BitTorrent and copyright collide

Posted by TerryH, January 16, 2014, running Mate.

Convert Video Files To Animated GIFs Easily

http://torrentfreak.com/
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As told to smileeb

May I introduce you to Agust.

How old are you?

I am 47 years old.

Are you married, single or what?

I am married. Next year, in August, we will be
celebrating our silver anniversary ­ 25 years married.

Do you have children or grandchildren?

I have two children, the oldest (Agustin) is 22 years
old and the youngest (Miguel) is 13 years old.

Are you retired or working and for how long and
at what.

I have worked in the same job since I was 12 years
old selling Italian coffee, and for 22 years I have had
my own company (Bravi Caffe Spain).

What is the area you live in like. (Weather,
Quietness, Scenery?)

Live in Burriana, which is a very quiet area of the
region of Valencia. It is an area almost entirely
devoted to the cultivation of oranges and the
manufacture of tiles. My house is just about 50
meters from the sea, and it is fantastic.

Are you handy with your hands and have any
hobbies.

Linux with e17 and fishing.

What is your education level?

Well, the truth is that work and study are bad
companions. Plus, my studies are very basic, but I
do have a graduation diploma.

Do you like to travel, go camping?

Traveling logically, if it is my job. Do I like camping?
No!

What caused you to try Linux and join this
forum?

Well in 2005, I was fed up with Windows, and I saw
some pictures of Linux and wondered what is that? I
tried it and I liked it, and the only distro that worked
well on my computer was PCLinuxOS, so between
the forum (Old) in mid­2006, what made me stay
was an e17 testing repo. The first user who helped
me in Linux was "KDulcimer", and since then I have
considered myself a "PCLinuxOS­User."

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by smileeb, featuring PCLinuxOS forum
members. This column will allow “the rest of us” to get to
know our forum family members better, and will give
those featured an opportunity to share their PCLinuxOS
story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
smileeb in the PCLinuxOS forum expressing your interest.

Where *BSD & Linux Converge

PCLinuxOS Family Member Spotlight: Agust

http://www.dosgamesarchive.com/
http://forum.fossconvergence.org/index.php
http://www.linuxforums.org/forum/
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by Meemaw

We’ve made bunches of pretty things with GIMP!
We’ve also done a little bit of photo editing, but I
know there are more tips to editing digital photos
than the ones I’ve covered already. When a digital
photo is opened for the first time, even expert
photographers will do something to improve the
shot. From Chapter 10 of the GIMP Manual, “Most
commonly the things that you want to do to clean up
an imperfect photo are of four types: improving the
composition; improving the colors; improving the
sharpness; and removing artifacts or other
undesirable elements of the image.”

Let’s look at some things we can do to improve our
photographs. I will follow the four topics listed in the
GIMP Manual’s Intro to Chapter 10 above. I have a
folder of photos from a recent trip to edit. I am going
to copy all of them into a sub­folder called Originals
before I start, just in case I really mess one up! Also,
remember, anything you do to a photo can be
undone just by pressing <CTRL> + Z or clicking on
Edit > Undo. Make sure you have your photo the
way you want it before you save.

Improving Composition

No matter how hard you try, sometimes you just
haven’t held your camera absolutely level. If you are
scanning a photo for saving, you haven’t placed it in
the scanner straight. Rotating your image will
remedy that error. GIMP’s rotate tool looks like this:
When you click on it, then click inside your
photo, you will find your photo covered with
a grid, and the rotate window will appear.

If you need to
rotate clockwise,
you should click
the up arrow next
to the angle, and
if you are going
counterclockwise,
the down arrow
should be clicked.
You can do it by
hand with your
mouse, of course,
but this is much
more precise. A
tip is to rotate a
bit, then click OK

to see how you did. Clicking in the center of your
photo will replace the grid squarely and you can see
if you have it rotated enough (or too much!) I rotated
this photo ­2.00 degrees,
then another ­1.5
degrees. I wanted the
signpost to be straight,
and I wasn’t happy with
it the first time. I clicked
the photo a third time,
and the signpost was
straight, so I canceled
out of that window. To
keep from accidentally
starting the rotate tool
again, I chose some
other tool.

Notice that the edges of the photo now have some
transparent sections. That’s because Gimp rotated
the photo, but there wasn’t anything to place in
those corners. One option is to crop the photo.

Choose the Rectangle Select tool and draw a
rectangle around your desired area. Click on
Image > Crop to Selection and everything

outside the rectangle will be eliminated. Another
cropping tool is the actual Crop tool. Your cursor will

change to a cross and you will be able to
draw a rectangle around the area you want to
keep, then press Enter or click on your

selection.

On either tool, you are able to adjust the sides of
you rectangle before you actually crop your photo,
just in case your rectangle isn’t quite where you
want it.

(This photo is of the entrance to the Miniature
Railroad Museum at Balboa Park in San Diego, CA.)

Connect connections in one
convenient location!

All your
PCLinuxOS

GIMP Tutorial: Editing An Image

http://pclosmag.com/links.html
http://docs.gimp.org/en/index.html


PCLinuxOS Magazine Page 13

Improving Colors

Exposure Problems

Heaven knows I’m not a perfect photographer! Most
of us aren’t, so we take loads of photos and then
weed out the bad ones, leaving us with the ones that
are most promising. Sometimes a photo will be really
good, except that it’s just a bit dark. We’ll want to do
a little color correction on that. The easiest tool to
use is the Brightness­Contrast tool. You can slide
the sliders or use the up and down arrows, which will
be easier if you only have to adjust a little bit.

I have a few photos that are just a bit dark, so I will
open one in GIMP and choose Colors >
Brightness­Contrast. A window will open that
shows sliders for brightness and contrast. You will
also see a checkbox that says “Preview.” Make sure
it is checked. As you slide the sliders or use the up &
down arrows next to the values, your photo will
reflect the change.

If you are tempted to use only the brightness setting,
I should warn you that some of your photos will look
washed out or way too light if you don’t adjust the
contrast as well. See the difference at center top:

(This is a photo of part of the bay in San Diego, CA.)

The Levels tool is another tool that can help you
adjust your highlights and shadows. I opened this
picture. It turned out really dark when I took it, and
after I used the Brightness­Contrast tool on it, I got
this result:

I said it was really dark! Then I chose Colors >
Levels. When the window appears, there are three
arrows below the histogram, one at each end and
one in the center. Adjusting the arrows below the
histogram, I was able to lighten the photo up
considerably (top, right).

Please be aware that large adjustments here will not
only lighten the photo, but add noise. However, a
slightly noisy photo where you can actually see
Uncle Jimmy and Aunt Sally is better than a dark
photo where you cannot (center, right).

This is a photo of one of the rooms in Whaley House
at Old Town, in San Diego, CA.

Adjusting Sharpness

I don’t know about you, but I can’t always hold
absolutely still while taking a photo, and it come out
a bit blurry. Many of those aren’t repairable, but
sometimes a blurry photo can be helped with a
couple of tools. One is Filters > Enhance >

GIMP Tutorial: Editing An Image

http://docs.gimp.org/2.8/en/gimp-tool-brightness-contrast.html
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Unsharp Mask, and it might be able to reduce some
of the blur.

Something else that might help is Filters > Enhance
> Despeckle. With both tools, you need to play with
the settings until you get the result you want. Be
very careful here, adjusting only a bit at a time, as
over­sharpening looks glaring and artificial.

If it seems too sharp, then you might try Filters >
Blur. Sometimes a photo will look better if it is
softened a bit.

Removing Unwanted Objects

I have taken a photo in the rain before. Then, when I
look at it, the rain detracts from the photo quality, of
course. Using Filters > Enhance > Despeckle may
be able to remedy that. Here, I took the photo
through a dirty windshield… despeckle didn’t take
everything out, but it looks better (right).

We have already learned how to remove unwanted
items in a photo using the Clone tool, which will help
fix the photo above, too. The Healing tool should
work as well. There is also the Resynthesizer plugin
available for Gimp, but it isn’t included in the default
Gimp installation. You can install it from the repo
through Synaptic.

Many photos have the dreaded red eye effect. To
remove it, use Filters > Enhance > Red Eye
Remover. You need to outline the area you want to
change with the lasso or ellipse select tool first.

Another method is to choose a brush (paintbrush
tool) with soft edges, and size it a tiny bit larger than
the red you want to remove, then paint a dark color
into the red. If it doesn’t look right, use <CTRL> + Z
to undo it, and try again.

Wow! We’ve covered a lot of tips. I am sure that your
photos will be even more beautiful now!

Before After

LinPC.us

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

GIMP Tutorial: Editing An Image

http://www.linpc.us
http://www.pclinuxos.com/?page_id=1413
http://www.linuxfoundation.org/
http://www.fsf.org
http://pclosmag.com/html/Issues/201212/page02.html
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Screenshot ShowcaseScreenshot Showcase

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

DOWNLOAD

Mate Desktop

Posted by Linuzoid, January 1, 2014, running Cinnamon.

http://www.pclinuxos.com/?page_id=10
http://pclinuxos.com/?page_id=188
http://pclosmag.com
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Ingredients

Preheat oven to 375 degrees (F).

1 large onion (Vidalia is best but any onion will do. I
used a regular yellow onion)

1/2 cup all purpose flour
1/2 cup milk
2 Tbsp canola oil
Spray Oil
1 tsp paprika
1/4 tsp garlic powder
1/4 tsp baking powder
1/4 tsp xanthan gum
1 large ziplock bag

It is very important to note the diagrams outlining
how far down to cut the onion. Failure to leave
enough uncut at the base will result in the onion
bloom to fall apart. No big deal, just try again :)

The solid black lines are the first main cuts. The red
circle on the bottom will be where you need to stop
cutting. The black dotted lines are the additional
cuts to create the petals.

1. Cut 1/4 of inch off the top of the onion. Peel off
outer skin. Turn onion upside down, roots up.

2. (BEFORE you cut, make sure to leave at least 3/4
inch from the roots for all cuts).

3. Make 4 equal cuts or quarters. Start your cut from
the top (near the roots) where the red circle would
start.

4. Cut each quarter 2 more times. A total of 12 sets
of petals will be created.

5. Gently spread the petals to open the bloom. Soak
in ice cold water will do the same.

6. Combine all dry ingredients in ziplock bag. Add
onion and gently shake to coat.

7. Take onion out of bag and shake off excess flour
in a bowl.

8. Pour remaining flour from ziplock into bowl; add
oil and milk.

9. Batter should be fairly thick. Add extra flour if
batter is runny.

10. Use your hands to coat all individual petals with
batter.

11. Place on a pan lined with parchment paper.
Lightly spray entire onion with oil.

12. Bake for 18­20 minutes. Allow to cool before
moving and serving.

13. Serve with your favorite dipping sauce. I'd serve
it with a creamy ranch dressing.

Baked Blooming Onion

PCLinuxOS Recipe Corner
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P C L O S
That's how I spell

Delicious Delicious
It's my favorite OS flavor

Give it a try you really will savor

P C L O S
I'm telling everyone I see

It's a bit of Linux
Made by Tex and Tux

PCLOS for me

P C L O S
That's how I spell

Delightful Delightful
It's the only thing on my computer

To run it I don't need a tutor

P C L O S
I'm telling everyone I see

It's a bit of Linux
Made by Tex and Tux

PCLOS for me

P C L O S
That's how I spell

Delectable Delectable
It didn’t cost me any money
Try it you’ll find it’s a honey

P C L O S
I'm telling everyone I see

It's a bit of Linux
Made by Tex and Tux

PCLOS for me

P C L O S
That's how I spell
Delovely Delovely

Get it you’ll feel so clever
You’ll run it for ever and ever

P C L O S
I'm telling everyone I see

It's a bit of Linux
Made by Tex and Tux

PCLOS for me
OGG MP3

ms_meme's Nook: PCLOS Candy

http://pclosmag.com/html/Issues/201402/files/pcloscandy.ogg
http://pclosmag.com/html/Issues/201402/files/pcloscandy.mp3
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SUDOKU RULES: There is only one valid solution to each Sudoku
puzzle. The only way the puzzle can be considered solved
correctly is when all 81 boxes contain numbers and the other
Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled for
you. You cannot change these numbers in the course of the game.

Each column must contain all of the numbers 1 through 9 and no
two numbers in the same column of a Sudoku puzzle can be the
same. Each row must contain all of the numbers 1 through 9 and
no two numbers in the same row of a Sudoku puzzle can be the
same.

Each block must contain all of the numbers 1 through 9 and no two
numbers in the same block of a Sudoku puzzle can be the same.

SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non­English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters
in your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to
12 minutes per letter tile set.
7. Have fun! It's only a game! Possible score 221, average score 155.

PCLinuxOS Puzzled Partitions

Tux Scrappler

D
o

w
n

lo
ad

P
u

zz
le

S
o

lu
ti

o
n

s
H

er
e!

http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201402/files/2014-02-PuzzleSolutions.pdf
http://www.scrabblepages.com/scrabble/rules/
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1. A recorded set of instructions designed to

perform a specific function.

2. Customize a document to look a certain way.

3. Series of pages for demonstration or

education.

4. Mini programs, like spell­check or mail merge,

that help you polish your document.

5. Arrange your data in a specific order.

6. Documents designed for a specific function,

which can be saved and customized.

7. Save file in a different form.

8. An expression which gives a desired result.

9. Alter menus, keyboard shortcuts and toolbars

so the program looks the way you want it.

10. Empty spaces around the outside of a

document.

11. Individual categories of information in a

spreadsheet or database.

12. To insert many addresses into a document by

combining them with the document.

13. Can contain your return address, or many

different addresses.

14. Arrange your document in a certain manner.

15. Rule used for sorting information.

16. Expression in a document which connects to

a website.

PCLinuxOS Puzzled Partitions

PCLinuxOS Crossword Puzzle: February 2014
Office Suite Terms

Download Puzzle Solutions Here!

http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
http://pclosmag.com/html/Issues/201402/files/2014-02-PuzzleSolutions.pdf
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Cells
Columns
Convert
Copy
Customize
Cut
Database
Draw
Export
Fields
Filter
Footer
Footnotes
Format
Formula
Header
Hyperlink
Labels
Layout
Macros
MailMerge
Margins
Options
Outline
Paste
Presentation
Print
Rows
Sheet
Sort
Spreadsheet
Table
Templates
Tools

A P T E P Q O H K Q E L U O E K Y Z Z S I S L E B A L H M T
Q Z J A X P V T W L W O H T C V T Y L H M O U C P S H Y K J
A I V E G R E M L I A M P R E S E N T A T I O N U R L J I X
W J W R F U G G B Z Z C I S I Q Y E J B A Y M J T P N F W Z
U S C V N J U R D C R P D W X J S T D P M Y Z L D S D E U G
M B F K L M L K K Z J M A R B E U O S D R K D R N E Y X R K
P B X C T V W D P S O R T S K U F S E T O N T O O F R C F D
V J T O A A S N T R J B X X T O P M E W F G I W Q R X J B A
V R N L Y U T R G W A I M S O E R Y Z J I T E S L O J K X V
G Q V L E U E Y B M J R E T K V S H I N P W Q N A L S W L E
U Y J F L V E I L E T E E X H E K D M O F M B X B A P L G T
C F T K N A H Z T N I R P D R P L G O M D N S V E X S U C E
V E R O K Q S R E P X N O S A V M F T Q P A D Z B T R O O E
R L C T U N G N L P N F F P V E D S S C H Q L Z J H F L J J
G S W G Q E I Q R K D T J M X F H L U O W Z E U U D Y C M L
I P M W V L E L T Q K W R N D E L S C Q Z L I I M Z O A Q B
L W G G T O Y P R Y Z E F O H E U F L C H R F A P R C J K X
J C Y U W G U F G E O J F I C S U Y P O C I W F I R O I E Q
S Z O Y B D L W Z O P C U H L N T V D P O C G Q O T J F P X
E E P Q F X M D G F I Y D H S T J P L Z F T P S T E E F J J
K J X T A F R S T P X W H Y P D E P D K E Q P T U M F L C S
B G T Y E T P I C L C G V Y R G G R B R S S Y U P P C E N Q
U K V Y H M Z O A J Q V M X E U V X R V A O G O C L N Y G T
I P U J C D A D E B D H P L A L T O B E B W G Y O A E N Y S
H L H W F H S R E F I I B N D W R C W F A F O A L T S N I H
I P A E H J K X G L V A T M S T G D U O T J W L U E V Q A A
E S P W B Y E L M I T Q E B H S D L M X A Y V C M S C M S R
L N T S D T S Z D X N H R A E L A P P X D Q C Z N A H U B V
U R C H F L S E I L Y S Y Y E P O H V F L C J F S K A F S G
Y U I I Z R U S T U K X R N T W K F V N F Z H Z R C Y J J N

PCLinuxOS Puzzled Partitions
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http://pclosmag.com/html/Issues/201305/files/2013-05-PuzzleSolutions.pdf
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by loudog

Now that we have a nice stable platform of basic
knowledge in Kdenlive, we will begin to dissect each
of the many effects in a much more detailed manner.
With that said, we want Kdenlive to be using our
prefered editing software for its effects stack and
MLT framework. Here is an image of my selections.
You may choose what suits you best.

As you will see, just one effect will require many
pages of instruction and guidance. Consider yourself
graduated to middle school at this point. With
graduation into higher learning there comes some
added responsibilities, namely homework. Well,
what can I say, like any good teacher I will be
assigning a little homework at the end of certain
articles, so you will be fully prepared for the next
lesson.

In this months article we will be building on our
previous work with single clips and more importantly
single images. Videos are just lots and lots of
pictures basically, and so the need arises often to
edit singular images. This knowledge will not be
required in this tutorial, but for next months
installment, you will want to have the basic skills
needed. The last consideration we need to explore
before we move on is image quality. Obviously an
image of 2160 x 1440 pixels will have twice the

detail of a 1080x720 image. After much
experimentation, I try to only use images in this type
of undertaking with no less than a 1920x1080
resolution. When zooming in, it is desirable to keep
pixelation at a minimum so the video looks more
polished.

This month, we will be learning a few different
effects and a few quick editing tips. Let’s start with
the quick tips. The first thing we will do is insert an
image into the timeline. Next, we want it to play for
longer than the default 5 seconds, so we stretch it
out in the timeline. I like to stretch my images out to
roughly 30 seconds or so and cut them down later, if
need be.

With that done, you may notice that Kdenlive has
added an effect by default. Since we are wanting a
different effect, we will remove this one. Click on the
effect (or video clip, or sound clip) and it will be
highlighted in red.

Hitting the delete key on the keyboard will remove
the selection from the project timeline, but not from
the project tree. If deleting an effect, it will be
removed from the effect stack.

Now you know how to stretch out an image clip and
delete clip/effect from project timeline. Let’s get to
the meat and potatoes, shall we? Our plan in this
tutorial is to set the hook, so to speak, on the picture
taking generation. We are going to teach you how to
breath some new life into those still images of yours.
Select three or four images that you like and import
them into the project tree (I will be using only two for
this tutorial, beginning and end). Drag the first image
into video track 1. Stretch it out, right click it and
select: Add effect/crop and transform/pan and zoom.
The effect will appear in the effect stack monitor.

At the top, we see the keyframe timeline with marker
and mouse cursor preparing to move the timeline
marker to the right. Over a little farther towards the
top we find the “save stack” etc. icon and the “delete
effect” button. Below that we see the “go to previous
keyframe” button, the “add/delete keyframe” button
(green + = add, red ­ = delete), the “go to next
keyframe” button, the “options” button and the
timeline “time” readout. Below those we have the
“align image” buttons, the “adjust to original size”
icon, “fit to width” icon and the “fit to height” icon.

KDenLive: Part Three
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Moving on, we have the “size indicator readout”
(hereafter referred to as zoom), the distort checkbox,
the background color indicator and the color pallette.
On the right hand vertical column, starting at the
bottom, the zoom slider (this does not alter the
project as far as I have experienced but is an
extremely helpful tool, you’ll see later), “fit zoom to
monitor size” icon, “origional size” icon, “update
parameters” icon, “show previous keyframe” icon,
and finally the “show path” icon.

As we progress through the tutorial, we will be
visiting most of these controls. The ones we do not
use, I will leave to you to play with and discover
what they do. The pan and zoom effect defaults with
the first keyframe queued into the timeline, as
indicated by a small black diamond above the
keyframe timeline. We may begin to manipulate the
image at the very start of the clip. First, lets take a
look at my beginning image (I have stretched it out
to about 30 seconds long in the project timeline).

As you can see the image does not fit the monitor.
The color on the sides is the color as shown in the
“background color indicator,” which indicates
transparency (checkerboard pattern, default). The
black color you are seeing is actually the back of the
monitor screen. To change the background color,
you can a) click on the background color indicator,
which will bring up a color selection screen, or b)
click on the color palette, move the palette cursor
over to the image and click it on any color in the
image you choose to change the background to that

color. In this instance I will select the “fit to width”
option, as this particular image is of high enough
quality and will not suffer from resizing. However, the
top and bottom will not show until we start panning
up/down and/or zooming in/out.

The cursor in the monitor (in the shape of a hand)
means that you have the option to grab the image
and position it manually, much like you would do in
Google Earth or Google Maps. The yellow “+” in the
monitor indicates the center of the image, and this
center target is what is referenced in the “X” (left and
right) and “Y” (up and down) position readouts. Now
that we have the image fit to the monitor width, lets
synchronize the project timeline marker with the
keyframe timeline marker. Click the “options” button,
and from the dropdown menu, select synchronize
with timeline cursor. Now both markers will move in
unison with each other.

Lets add a keyframe. I will move the keyframe
timeline marker over about 5 seconds (the time
readout shows 5.16 seconds in the example). Click
the “add keyframe” button (green +), and zoom in to
about 135% or thereabouts (size indicator readout or
“zoom”). Note: To add a keyframe you can also

just double click anywhere on the keyframe
timeline or to delete, just double click on the
little black diamond keyframe indicator.

When using the zoom feature, you can either type in
the desired size (I generally highlight the value I
want to edit), or initiate a slider action by holding the
cursor on the “size” text until it shows as a pointing
hand. At that point you may click and hold while
“sliding” the cursor left and right to zoom in or out.

If you use the keyboard method you must hit the
enter key on the keyboard to view the newly resized
image in the monitor. After the image is resized, I will
recenter it in the monitor using the “align image”
control buttons. I will center the image vertically and
horizontally.

KDenLive: Part Three
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This sequence of keyframes instructs the camera to
zoom in on the center of the image, from the first
keyframe size (100.00%) to the next keyframe size
(137.03%), over a period of 5.16 seconds (actually
addresses but we covered that in last months
article). Now lets add another keyframe about 8
seconds or so into the timeline and zoom in again to
300.00%. Recenter the image. Add another
keyframe of about 2 seconds. For this short duration
between keyframes, we just want the camera to hold
steady for the 2 seconds, basically a pause, so we
add no effects. Next, add another keyframe about 6
seconds further down the timeline. Zoom out to
200.00%, and then, grabbing the image in the
monitor with the cursor, move it to your desired
position for that keyframe. This time I am instructing
the camera to zoom out a little, and at the same
time, pan to the left side of the image and hold on
the face I see in the tree trunk. I will add another
pause here with a new keyframe. Next, I will add
another keyframe of 4 seconds or so and zoom in on
the perceived “face”. Note: The longer the duration
between keyframes, the slower the zoom/pan
action will be, and visa versa.

Do you see the face?.... Yes?... No?... Hmmm, must
be the beverages. Why don’t we give the audience

another 2 second pause here to examine the image
and see if they discover the face looking at them
(add each keyframe as you go) and then a 4 second
zoom out to 75%. Note: It is much easier to add
the zoom first to the keyframe and then the
desired “pan to” position. Another 2 second
pause. Now play the clip in the monitor (click rewind
then the pause button to reset the player) and
decide if you like the effects so far. Note: The
playback will appear very choppy in the monitor
until the project is rendered and viewed in an
appropriate video player.

Using the go to next/previous keyframe buttons will
speed up the editing process, allowing you to switch
from one keyframe to the other very quickly. Go
ahead and click on them, toggle back and forth
between keyframes, get comfortable with them; they
will become your buddies later. If you decide that a
keyframe needs to be added, all keyframes beyond
this should be deleted (reset) and done over.

In my experience, the effects sometimes get messed
up if you do not do this. That’s why it’s important to
review the project often in the monitor as you create
it. If, on the other hand, you decide to remove a
keyframe, just navigate to it and click the red “delete
keyframe” button. After reviewing the video, I have
decided to add a keyframe partway through, so I will
reset all keyframes from that point on (all keyframes
including the one the marker is on will be
deleted/reset). To do this, I will select which
keyframe I want the reset to start with. Then, using
the options icon again and from the dropdown menu
select, reset keyframes After cursor.

Now that I have added the extra keyframe I wanted,
and recreated the deleted ones, lets have a quick
look at our selected camera pan path. First rewind
the player. Next, click the “show path” icon. You will
see the established path show up in the monitor. As
the camera pans to the left, the center target moves
to the right. When panning up, the target moves
down. This center target’s path is what is
represented by the red line. Play the clip and watch
the image center target follow the path.

KDenLive: Part Three
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Now it’s time to prepare for the transition to the next
image. I will zoom in to 850%, over a period of three
seconds (I want the zoom in to be very quick), and
then I will position the white foggy part of the image
in the monitor. I have decided on a rather ominous
looking thunderstorm for my next image. The white
foggy part of this image will transition nicely to the
light part of the thunderstorm clouds in the next
image. For the last keyframe, I will need a 10
second pause to allow more than enough time for
the transition effect to be edited in effectively. Since I
don’t have enough time left in the clip on the project
timeline, I will simply stretch the clip out a little more.
After reviewing the video one last time and being
happy with the way the effects look, it’s time to
render this “project”. I will be using these settings.
Since the project does not contain any audio yet the
audio bitrate is ignored by default, even though the
readout says 384.

I have named the output file, and it will be saved as
an .avi video. What? Not again! Yes again, review
the rendered .avi file in your favorite video player
and look for errors before moving on. Note: Never
delete your project or clear the project timeline
until rendering has finished and you have
reviewed it in your video player, so if need be,
you can make small edits to the existing project
instead of rebuilding the whole thing from
scratch.

Now that we are happy with the first clip, lets clear
out the project timeline, drag our next image into the
project (our ending image in this tutorial), stretch it
out and add the pan and zoom effect. Note: It can
be quite helpful to have the audio file in the
audio track timeline so you can get an idea on
how long you need to stretch out the last image
to match the audio length. This image does not fit
the screen either, much like the first one, but instead
of using the “fit to width” option this time, we will click
the distort checkbox. Uhhh huh, something new.

This effect will fit the image to the screen, but
because of the stretch/compress qualities involved,
it does not work well with all images. Some images
may end up looking “overly distorted.” Since I desire
a rather large blurry white background to transition
to, I will start by zooming in on the image to about

800%. Now, instead of grabbing the image and
manually positioning it this time, or using the
centering tools and groping around from there to find
my whitish spot, I will use the zoom slider at the right
hand side of the screen to find my sweet spot. Yep,
video editing is a game you learn as you go.

When I zoom out from the image with this
tool, a small box with a red border
appears in the monitor. This small box is
what will show in the monitor when it is
“actual size.” You probably already
recognize the center target and diagonal
center line, as well as the grabber hand.

If you zoom out even more?…….
Yessss,,,, you gettin all this?

The box with the yellow border is the full image.
While you drag around the yellow box the red box
updates the selected section. With this tool you can
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quickly move to any part of the image and have a
good idea of what will be displayed when it is
zoomed back to the proper size. This slider is
invaluable for time saving edits on pan positioning
and zoom. Play with it, discover all that it can do to
help you speed up the creation process. Note: The
editing options on the side of the effect stack
window are designed to be complementary tools,
to be used in conjunction with the zoom slider,
experiment with them.

Now that I have quickly found my whitish transition
section, its time to move on. Setting the next
keyframe for a four second pause, I will then zoom
out to 100% with the next keyframe. I want the
image centered and I also want the zoom out to be
very slow, so I allot 15 to 20 seconds between
keyframes. The closing effect will be a fairly quick
zoom out to 1% (about 3 seconds) giving the “poof,”
bye­bye, all gone ending.

After the traditional review, I render the file and
again, review the rendered file. Okay, things are
going well and we are happy with the rendered file
so lets clear the project timeline. Import the two .avi
files, place the first one in track 1 and the second in
track two. Overlap the videos a little, and place the
cursor at the bottom right corner of the top clip.
When the cursor changes to a pointer hand and the
corner starts to blink green, click to add the default
effect.

The default effect using this method is dissolve. The
first track dissolves away while the second track
materializes. After the effect is set, review it and
make adjustments as necessary for a fluid transition.
I have discovered that the static ending of my first
video is too long for a smooth transition, so I will
need to cut it. To do this, I will first move the bottom
clip over to the right so it is out of the way, then
position the project timeline marker at the point I
want the cut, right click on the clip and select cut clip
from the menu. Note: Any tracks that are covered
by the project timeline marker will be cut.

After the clip is cut, its a simple matter of selecting
the unwanted part, and deleting it from the timeline.
The effect may have to be shortened.

Now I will reposition the clips to overlap again, and
adjust things to my particular tastes. After the review,
I will add the audio (and my standard intro clip),
render the file, review the rendered file, and then
send it to friends. At this point, you can imagine all
the possibilities with this single effect. Give it a try,
create, have fun, and enjoy the toys the the open
source community has gifted you. Any questions you
may have can be posted to the software section in
the forum. To view the video we created in this
tutorial, go here. The YouTube player is not near the
quality you will get in house. So Alice, you ain't seen
nothin yet. If you want me to show you just how
deep the rabbit hole goes … then I suggest you do
your homework. Next months article will be as much,
if not more, fun and informative as this month, if you
read these two articles featured in previous issues of
the PCLinuxOS magazine. (Lesson 1) (Lesson 2).
Until next month, later tater.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http://twitter.com/iluvpclinuxos
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by Paul Arnote (parnote)

OK … I know that the GUI Linux desktops have
gotten really good. And, I know that there are many
users who avoid using the Linux command line – at
all costs. But learning to use a terminal emulator,
and the Linux command line, is not only fun, but it
also gives you more power and control over your
system. Below are some assorted tips and tricks that
I use, and that will give you greater control over your
terminal sessions.

Close Terminal, Keep The Program

If you start a program from the command line,
closing the terminal session will typically also end
the program you started – unless you started the
program to run in the background. Certainly, you can
run any program in the background, simply by
adding “ &” to the end of the command, like this:

gcalctool &

But what if the program is already running, and you
want/need to close the terminal, but want the
program to keep running? Fortunately, Linux gives
us a way to change whether a program launched
from the command line is running in the foreground
(default) or placing it in the background after it has
already been launched.

To specify for a running program to run in the
background, do the following:

On the keyboard, hold down the Ctrl + Z keys (will
show up in the terminal as ^Z, with “Stopped [name
of program] on the very next line). This will
temporarily suspend the running program (the
program you started from the command line).

Next, enter the following at the command prompt:

disown ­h %1
bg 1

Now, the terminal will be “de­listed” as the parent
process or owner of the program’s process, and the
program will be moved from being a foreground
process to a background process. After it is moved
to the background, the program will resume its
execution, but as a background process. You can
now close the terminal session without stopping the
execution of the program. Also notice how, after the
issuance of the “bg 1” line, gcalctool is listed as
gcalctool &, signifying that the program is now
running in the background.

Open Terminal Where You Want

On most desktops, your terminal will open at the
upper left corner of your screen when you select to
open it from either a launcher or the applications
menu. Most of the time, this is fine. But what if you
find it more convenient to your style of working to
have the terminal open up at a different location?

Fortunately, this is easy enough to do. Most of the
popular terminal programs allow you to specify the
width (in characters), height (in lines), along with the
X and Y screen coordinates where the window will
be placed. For most of the popular terminal

programs – except xterm – the format is as follows
(all on one line):

­­geometry=[width]x[height]+[X­
coordinate]+[Y­coordinate]

Simply add this command line switch to the end of
the command that launches your favorite terminal
program. If you typically launch your terminal
program from a launcher, edit the command in the
launcher. If you typically launch your terminal
program from your application menu, you may have
to edit either the menu (in the case of KDE), or the
.desktop file (in /usr/share/applications as the root
user) to include the command line switch.

Now, remember that I said that xterm was the
exception. If your favorite terminal program is xterm,
the command line switch is slightly different … yet
very similar. Simply eliminate one of the leading
dashes and the equal sign. For example, xterm
­geometry 80x20+100+100 will open the xterm
window, 80 characters wide, 20 lines tall, at X­
coordinate 100, and at Y­coordinate 100.

Exclaim it!

It’s not at all uncommon to issue multiple commands
while working at the command line, but nothing is
more cumbersome than having to retype the same
command over and over. Fortunately, there is a
shortcut. Just type ! followed by the name of the
command and it will be recalled. Just press the Enter
key to execute it again.

Some Handy Terminal Tips
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For example, let’s say we were using the command
line to open a specific configuration file in your
favorite text editor. My favorite text editor is Xfce’s
Mousepad, so I’ll use that in my examples. Typing
!mousepad will recall the last command that
launched Mousepad from the command line, and
pressing the Enter key will launch it.

REALLY Exclaim It!!

While the previous shortcut depends on the name of
the command you want to repeat following the single
exclamation mark, the double exclamation mark
allows you to recall the previous command, and
doesn’t require the name of a command to function.

Where this is especially useful is when you need to
preface the last command with another command.
For example, let’s say that you opened a
configuration file as a regular user for editing, but
then realize that you need to open that file as the
root user. Simply typing “gksu !!” (or “kdesu !!” under
KDE) will execute the command after gaining root
access with either the kdesu or gksu command.

Get Historical

One extremely powerful command to use while
working on the command line is the history
command. Executed by itself, it will list all of the
commands you have used on the command line. If
you use the command line regularly, you will have a
lot of entries. Each command line entry is assigned
its own unique number. On one of my computers, I
have over 1,000 entries! Scrolling through all of
those commands is not only tedious, but it increases
the chance that I will miss the command that I’m
looking for when scanning within the long list.

Fortunately, you can improve your chances of finding
the command you are looking for. Let’s say that I’m
looking for the times that I’ve used the convert
command (part of the ImageMagick command line
tools). Use the history command combined with the
grep command, like this:

history | grep convert

Since I already know what I’m looking for, I can
weed out all of the other commands in the command
line history. Now, all I have to do to re­execute the
command is issue the command “!728”, since 728 is
the number assigned to the particular command I’m
seeking in the history command’s log.

The last time …

Another way to access the last iteration of a
command is to use the Crtl + R key in a terminal
session. Keep in mind that this shortcut will ONLY
recall the last use of the specified command.

Notice that the command prompt now changes to
(reverse­i­search) and as you start typing (I typed in
“mou” without the quotes), the last command that I
used the mousepad command in is shown. Simply
pressing the Enter key will re­execute that
command.

This is especially helpful if you just used the mv
command to move a file to another directory, and
you want to check the path where you moved the file
to. It’s also especially helpful if you can’t remember
the exact syntax of a command that you previously
executed successfully.

Moving between directories, the easy way

It is tedious, to say the least, to use the cd command
to move between directories, especially if the
destination directory is several layers deep. The
deeper the destination directory is, the longer the
command to move there, and the greater the chance
of making a typo.

Fortunately, there are some shortcuts you can use.
First, cd ­ will switch between two directories. Note
the space between cd and the trailing dash. Second,
cd ~ will automatically take you back to your /home
directory, no matter where you are in the file
structure. Just as with its cousin, note the space
between cd and the trailing tilda.

Using the pushd command, instead of cd, will cause
the current directory to be written into the popd
variable, then take you to the specified directory. To
return to the previous directory, simply type popd.
Unfortunately, this only works once. You can easily
circumvent this restriction by simply using the cd ­
command. With it, you can switch between two
directories ad nauseum, forever … if you wish.

Some Handy Terminal Tips
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Kill it dead

Sometimes, you have a program hanging around
and refusing to close. Fortunately, there are a
quartet of Linux commands at your beck and call to
show the stubborn program just who the boss is.

The kill command, issued from the command line,
heads up these four commands. The only argument
it takes is the PID (program ID) of the program that’s
misbehaving. What? You don’t know where to find
the PID? Well, you could issue the top command in
your terminal. The first column lists the PID of the
running programs. Or, you could just type pidof
[program name] and the PID will be returned. Then,
just use the PID as the command line argument for
the kill command.

The killall command takes only the name of the
program as a command line argument. So, if you
have several windows on your desktop that are all
under the control of one program – let’s pick on
Firefox – then issuing the killall firefox command
will close out all of the windows under the control of
Firefox. Similarly, if you have multiple copies of a
program open, all of the instances of the specified
program will be closed.

The pkill command is a shortcut way to close a
program, and it takes only a portion of the program
name (or the entire name) as its command line
argument. In the example above, I used the entire
name, but using pkill gcal, pkill tool or pkill lcto would
have also closed the program gcalctool. Thus, pkill

fire, pkill fox, pkill iref, pkill firefox would all close the
Firefox browser.

The xkill command only works on an X Window
system, and isn’t installed by default in PCLinuxOS
(the other three are). However, you can install it via
Synaptic. When executed, your cursor will change to
an X. Simply click the X cursor on the window of the
program you want to close. The program under the
X cursor will close, and your cursor will revert back
to normal.

Heads & Tails

If you’re working in a terminal session, there’s no
reason to leave that environment to read a simple
text file – and on Linux, there are a ton of them.
Most of the configuration files on Linux are nothing
more than simple text files.

Of course, I’m talking about the head and tail Linux
commands. One (head) reads the first part of a text
file, while the other (tail) reads the last part of a text
file, all without opening or loading them into a text
editor.

Their usage is very similar. You simply issue the
command, followed by the name of the text file you
want to view. Issuing either command, coupled with
the name of a text file, will display the first 10 lines of

a file (in the case of the head command), or the last
10 lines of a file (in the case of the tail command).

You can also change the behavior of both
commands to display more lines than just the paltry
default 10 lines. Simply insert ­n[number of lines]
between the command and the name of the text file
to display. So, if I wanted to view the first 20 lines of
a text file, I’d issue the head command as head ­n20
mylist.txt. Similarly, if I wanted to view the last 20
lines of a text file, I’d issue the tail command as tail
­n20 mylist.txt. You can view however many lines of
the file you want, simply by specifying the number of
lines to display. If you want to view the entire file, just
make the number larger than the number of lines in
a file (100? 1000?).

Summary

Whatever you do, don’t shy away from learning the
Linux command line. A few years back, I viewed the
Linux command line as something that I had to
sometimes reluctantly use. To me, it was the great
black hole. But after setting my mind to learning it,
the veil of mystery lifted from the Linux command
line, and I soon realized how valuable it could be. In
a lot of instances, the command line is much faster
than using the GUI version of a program. Plus, the
Linux command line can be fun.

Some Handy Terminal Tips
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by Meemaw

A couple of years ago, I did a series on photo
viewers. Over five months, I covered more than
twenty different photo viewers. However, I haven’t
noticed this one before. Album Shaper is a photo
viewer program that lets you build albums from your
saved photos, and even generate a web album. It is
installable from Synaptic.

Album Shaper has a different organizational system.
An album can be divided into sub­albums, called
collections, as shown below:

Album
|_ Collection 1

|_ Photos
|_ Collection 2

|_ Photos

One album could be called “My Vacation”, then each
collection could be named by date, so if a vacation
lasted several days, as they usually do, you can
keep the photos in chronological order without
possibly doing some intensive file renaming.

When you open Album Shaper, you will see the main
window (center, top), which has a section for album
name, description and author as well as one for
collection name and description. The album name is
the one that will name the entire group, while the
collection name will name the first sub­group. Also
notice two tabs at the top of the largest section of
the window. One says Organize and, when you get
photos there, the other tab says Edit. Let’s start
adding photos first.

First, I named my album Vacations, and named my
first collection Colorado 2012, just to give myself
somewhere to start. Clicking the “Add Photo” button,
I was presented with a window to browse to the
folder where my Colorado 2012 photos were stored.
From here I can add as few or as many photos as I
want, simply by choosing them one at a time,
selecting a range of photos using the Shift key, or
holding down the <CTRL> key and clicking on the
photos I desire.

Notice at the bottom a checkbox that says “Use
filenames for descriptions.” If you had already gone
through your photos and named them something
meaningful, you can check that box and those
names will be added to the description with your
photo. If you have filenames from your camera, as I
obviously do, you can add descriptions to your
photos. We’ll do that in a bit.

If you added several photos, but you have
discovered that you forgot a few of them or want to
exchange a few, don’t worry. In your thumbnail
window (the Organize tab), you can still add to the
collection by clicking the Add Photos button again.

They’re out of order now? That’s ok… grab one of
them by clicking the mouse and drag it over to the
correct spot in the thumbnails. Also, if you find one
you didn’t mean to add, select it and click Delete
Photo at the bottom of the window.

If your file name isn’t very descriptive, you can add a
description to each photo by clicking the blue icon
you find when you hover your mouse pointer in the
bottom right corner of each thumbnail. When you
click on that icon, your photo opens a bit and a
space appears below or to the right of it which
allows you to add the description.

Make Your Own Online Photo Album
With Album Shaper

http://pclosmag.com/html/Issues/201105/page16.html
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Buttons also located at the bottom of the main
window are the rotate buttons and the wallpaper
button. If you find that one of your photos needs to
be rotated, just select it and click the appropriate
button. If, in your photo organizing, you decide that
you would like to set a certain photo as your
wallpaper, you don’t have to go any farther than the
bottom of this window. However, so far, I haven’t
gotten this feature to work.

If you haven’t saved your album yet, you need to do
so. Click on File > Save As… You will see a window
where you can choose a location to save. In this
case you are naming a new folder in which to put all
the information and thumbnails that go with this
project. NOTE: This means that your original photos
are not changed or deleted. The program makes
thumbnails of each photo you add, and all work is
done to the thumbnails. As you can see, I named my
folder Vacations. Now my Pictures folder has a
subfolder named Vacations. The theme at the top of
the save window will be the appearance of the web
album, if you generate one.

For your album and each collection, you can choose
a photo to be a “cover photo.” Simply choose

the photo you want to use, right­click it and choose
“Set album image” or “Set collection image.” The
thumbnail will appear to the left of the album or
collection name above or at left. Alternatively, you
can choose a photo and drag it to the desired spot
on the left of the album or collection name.

While you are in the program, there are several
editing tools you can use. From your Organize tab,
double­click on a photo, and you will be taken to the
Edit tab with your chosen photo in the center.

You see three sections. At left, the Frame section
contains Rotate (clockwise & counter­clockwise),
Flip (horizontal & vertical), Straighten (the green
arrow) and Crop (on the second line and includes
some default sizes in the drop­down). I’m sure most
of these are self­explanatory, but the Straighten
button is interesting. In my GIMP article (elsewhere
in this issue), I discussed rotating a photo just a few
degrees. This button makes it easy. Simply click the
button and, using the tool that replaces your mouse,
draw a line through the object that needs to be
straightened. When you let go of your mouse button,

the program will straighten that photo along the line
you drew.

The center section, Enhance, contains editing tools
for color, contrast, red eye, levels and grain.
Experiment with these to edit your photo. Remember
that small adjustments at a time are more likely to
give you what you want.

The right section, Manipulate, gives you several
effects to give variety to your photos. You can alter
your thumbnail six different ways:

I changed one of mine to a sepia tone (next page,
top left). Remember, this is done to the thumbnails,
so the original photo is untouched. By the way, if you
apply an effect or edit and decide you need to undo
it, there is no Undo button. However, clicking on
Photos > Revert to Original will give you your
original thumbnail back.

Make Your Own Online Photo Album With Album Shaper
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From the File menu, you can generate a web album
or a set of photos to be printed. From the File menu,
choose File > Export > Small Web Album. You will
again be asked where to save it. I used the same
folder, Vacations. I got a subfolder called
Vacations_WEB. Opening that folder, I see an HTML
file called index.html. That file will open in my web
browser.

Here you see my album cover photo at the top with
the collection cover photos beneath. Clicking on one
of the collection photos opens the collection for
viewing. You can see the whole thing here. If you

lack a website to host your photo album, you can
also use the Public folder of your Dropbox account.

You can export photos for printing by clicking File >
Export > Images for Printing. This is probably the
thing I like least about this program. I haven’t found
anything in the program that will actually print the
album: it just puts all the photos in the album in a
single folder.

Overall, this is a kind of neat program. The albums
look good, and the editing tools work well. If you
haven’t found a program to do your photo albums,
this one may fill your needs. The good thing about
the web album is that you can share your photos
with your family and friends on the web, no matter
what operating system they use.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

It's easier than E=mc2

It's elemental
It's light years ahead

It's a wise choice
It's Radically Simple

It's ...

Make Your Own Online Photo Album With Album Shaper
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by YouCanToo

As 2013 was coming to a close, PCLinuxOS
community member izto posted his desire to be able
to print a photo calendar, but he wasn’t familiar with
how to do so.

After searching for a calendar making program, I
came to the conclusion that they all had some
drawbacks. Some of the ones I found on the web
took longer to watch the instruction on how to create
them than it did for me to make my own. Photo­cal
was a nice stand alone program, but was seriously
out of date. It only made calendars to 2013. Then
there is Digikam, which would work for most anyone.
But, to add things like holidays, it sent you on a wild
goose chase to another website, which had no
download link!

So, what is a person to do, if they just want
something simple with no big thrills? Create your
own using LibreOffice Draw!

I set off to work to see what it took to create a
simple, usable calendar.

First, I had to decide just what I wanted my calendar
to look like. I chose a simple picture over the
calendar on a single sheet of 8 ½ x 11 inch paper.

Now that I had chosen my layout, I decided that I
needed a table of seven columns and seven rows.

Next I had to decide on how many different
templates of this I would need to make to account
for the different starting days of the months. I quickly
opened in a terminal and typed in cal 2014 and
started counting them (center, top).

I started by writing every day of the week and
marking which months started on which days. This is
what I found out.

Sun ­ June
Mon ­ September, December
Tue ­ April, July
Wed ­ January, October
Thu ­ May
Fri ­ August
Sat ­ February, March, November

I would need seven different templates to make a full
year's calendar.

I opened LibreOffice Draw and got to work creating
my template. I created a simple template with the

basic layout of a table with seven rows and seven
columns and then saved it for the seven different
layouts I would need.

I grabbed and dragged the table box to fit the size of
my paper.

Now I chose the properties I wanted for the table
cells (next page, top left).

The top row of cells will hold the days of the week. I
then entered the days of the week in each cell. I
then highlighted the cells and, left clicking on the
cell, then I chose format cell and align to the center.
Then, while the cells were highlighted, I chose my
font and selected bold.

Make Your Own Custom Photo Calendar
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Now I save my basic layout by clicking on File ­>
Save as Template ­> clicking Save in the template
manager window and entering the filename. In my
case I choose the filename 'basic­plain­box­with­
squares'.

Now, using my basic layout, I will create 7 layouts for
each day of the week using the following
information.

The months that start on the following day of the
week.

Sun ­ June (30 days)
Mon ­ September (30 days) , December (31 days)
Tue ­ April (30 days), July (31 days)
Wed ­ January, October (31 days)
Thu ­ May ­ (31 days)
Fri ­ August (31 days)
Sat ­ February (28 days) , March (31 days) ,
November (30 days)

Using my basic layout, I highlighted the last six rows
and and chose to align the cells to the top and set
the font to Bitstream Vera Sans Mono with a point
size of 18. I then saved this as a template file. I
repeated the above process, creating each of my
weekdays (below and right).

Now I used the appropriate daily template to create
my monthly calendar template. I added the name of
the month and date to the top of each monthly
template.

Choosing the text tool at the bottom of LO Draw, I
then selected my font Bitstream Vera Sans Mono
with a font size of 36 point and bold. Drawing a text
box, I typed in the month and year, and then
centered it above my calendar layout. Once I was
satisfied with the way it looked, I saved it as a
template using the name of the month. I repeated
this for each month of the year, using the proper
starting day of the week (next page).

Make Your Own Custom Photo Calendar
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Now I was all done, except for an image for each
month. First, I chose the images I wanted for each
month, and then opening the said monthly template.
I added the image by clicking in a blank spot in the
template, selecting Insert ­> Picture ­> from file,
and selecting the image I wanted, then clicking
open.

I then sized the image to fit the upper portion of my
calendar page (right).

That looks good to me.

Have fun making your own personalize calendar(s).
To make it simple for you, I have made my templates
available here: http://pclosmag.com/Misc­
Downloads/calendar­templates.tar

To use these templates, save the file to
~/.config/libreoffice/4/user/template. Then, from a
console window, enter the following command to
untar the file: tar xvf calendar­template.zip

Now your new templates will show up in LibreOffice
Draw.

Linux Docs
Linux Man Pages

Make Your Own Custom Photo Calendar
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by Paul Arnote (parnote)

Internet users across the globe – except for some webmasters – definitely have
one thing in common: they hate and despise the tons of advertising that is
crammed down our throats on a daily basis. Do the advertisers really think people
click on those ads? Does anyone except for the most computer illiterate user
actually click on them? For me, they provide a cause to avoid those products.
After their unwelcome intrusion on my space, those “products” will be the last
ones I consider when making a purchase.

Sure, there are browser specific extensions, such as AdBlock and AdBlock Plus,
that help eliminate the continual assault of the endless advertising barrage. Sure,
you could install one of the aforementioned browser extensions. But the problem
is that they aren’t an across the board cure. If you install AdBlock Plus in Firefox,
that single extension is exclusive to Firefox. To accomplish the same thing in
Chrome or Chromium, you have to turn around and install a version of AdBlock
Plus that’s exclusive to that particular browser.

But wait a minute! There is another way. The “other way” works across the board,
and you only have to install one program from the PCLinuxOS repository. Install
just one program that works across any web browser that you may happen to be
using. Put an end to installing multiple, browser­specific versions of the same
extension. It’s called Privoxy.

Getting Started

First, install Privoxy from the PCLinuxOS repository, via Synaptic. The typical and
usual advice to insure that your computer is fully updated before installing
programs from Synaptic should go without saying.

The first time you use Privoxy, you will need to manually start it from the
command line. As the root user, issue the following commands:

service Privoxy start

netstat ­nap|grep Privoxy

Take notice that the second command provides the proxy address and port that
Privoxy is using. The default value is 127.0.0.1:8118 (listening in on localhost, on
port 8118). On subsequent reboots, Privoxy will be set to start when you boot
your computer. You only have to perform this step the first time you use Privoxy.

Now, if you use Firefox and ONLY Firefox, you can use this information to setup
Privoxy’s proxy information within the Firefox settings (Edit > Preferences). Go to
the Advanced tab, then the Network tab. Click on the top button, marked
“Settings.”

Ad-free Browsing With Privoxy
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Select the radio button next to “Manual proxy configuration,” then fill in the HTTP:
Proxy field with 127.0.0.1, and set the port (immediately to the right) to 8118. It
probably is a good idea to place a check in the box immediately below, labeled
“Use this proxy server for all protocols,” as well.

This is all good and fine, if as we said, you used Firefox, and only Firefox. But
then, you’re handcuffing the abilities of Privoxy. Very few users use only one web
browser. I personally have four installed on most of my computers: Firefox,
Chrome, Chromium and Midori. Even an out­of­the­box PCLinuxOS KDE
installation will have a minimum of two different browsers installed (Firefox and
Konqueror).

So, let’s skip setting up Privoxy only in Firefox. Within the dialog box above, set
Firefox to the “Use system proxy settings” instead. Rather, we’ll go into PCC and
set up a system­wide proxy that will work not only with Firefox, but any web
browser you have installed on your computer.

Open the PCLinuxOS Control Center (a.k.a. PCC, or Configure Your Computer),
and go to the Network & Internet tab on the left side of the window. About halfway
down the right pane, click on Proxy. Enter “http://127.0.0.1:8118” on the first line,
and place a checkmark in the box in front of “Use HTTP proxy for HTTPS
connections” setting. Click the OK button at the bottom right corner of the
window, and OK in the next window. Now you will need to logout and back into
your computer for Privoxy to be active and able to perform its duties.

KDE (and Gnome) users will have one extra step to perform, since those two
desktop environments add another layer to the use of proxies. Select “Configure
Your Desktop” (a.k.a. KCC), then go to Network and Connections > Network
Settings > Proxy. Select the radio button next to “Use system proxy

configuration,” then select the “Auto Detect” button. Then, select the “Apply”
button at the bottom right of the window.

Full Monty ...

Everything you might want or need –
plus the kitchen sink!

Ad­free Browsing With Privoxy
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Tweaking … Not Twerking

As it sits, with its default settings, Privoxy works. Below are some examples.

The Omaha World Herald site without Privoxy (top) and with Privoxy (bottom).

My hometown newspaper without Privoxy (top) and with Privoxy (bottom).

In the images above, notice the lack of ads on the pages displayed after the use
of Privoxy. It’s proof positive that Privoxy works.

However, Privoxy can do so much more. To get an idea, check out Privoxy’s
online user manual. There are many settings you can tailor to your internet
browsing needs. While we’re not going to go over all of those (everyone’s tastes
and needs can vary widely), let’s talk about what you need to do to give yourself
the option of changing Privoxy’s settings.

First, check out Privoxy’s built in web­based configuration page, which allows you
to control Privoxy from within your web browser. Don’t worry – you’re not
connecting to anywhere on the web. The configuration page is right on your
computer, so you are accessing only your computer. Select the first link under the
Privoxy Menu section (near the top). By default, you can only view the settings
(as in the image above), so let’s change things so that you can tailor your copy of
Privoxy.

As the root user, open the file
/etc/privoxy/config in a text editor.
About half way through the file, look
for the “enable­edit­actions 0” entry.
Change it to “enable­edit­actions 1”
and save the file. Close out your
text editor. Now, refresh the
“showstatus” configuration page.
Your page should look like the one
shown to the left.

Ad­free Browsing With Privoxy
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Now, when you select one of the “Edit” buttons, you will see all kinds of settings,
similar to that displayed below. Clicking on the third “Edit” button down causes
the following to be displayed (you may have to scroll down the page a bit).

Clicking on the displayed “Edit” button will bring up a window similar to the one
below.

Scrolling down the page, you will find many, many settings you can enable or
disable. Read through them and enable (green column) the items you want to
block – and disable (red column) the items you wish to allow. The blue column
leaves the item set to the default values in Privoxy.

Summary

Overall, Privoxy is an outstanding way to block unwanted advertising when you’re
browsing the web. But don’t be afraid to dig into the other capabilities of Privoxy,
which can even serve as a parental content filter. You just have to set it up.

Privoxy is a complete solution for filtering out the web content we don’t want to
view – or that we don’t want users on our computer to view (like little Johnny and
little Susie). With Privoxy, you can now set up ONE content filtering solution that
works on all browsers, as opposed to having to install a separate one on each
browser you use.

Screenshot ShowcaseScreenshot Showcase

Posted by bones113, January 16, 2014, running KDE.

Ad­free Browsing With Privoxy
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by loudog

For this tutorial I will select one of my special
recipes. Note: Brewing alcoholic beverages at home
may not be legal in your area. Please check your
local laws before brewing.

Now that the recipe has been loaded, let's check the
style parameters.

OK. Everything looks within the style parameters so
let’s get started. We will begin by selecting the
brewday tab and see what step 1 has to say, but first
some pre brew day orders, aah, I mean, information.

For your first brew, plan on having at least 4
hours to set up, boil your brew and to clean up
the mess. Make it easy on yourself, allowing
plenty of time with as few distractions as
possible. Don't worry too much about mistakes
as extract beer brewing is generally very
forgiving, and many a great recipe has been
discovered through mistakes. Keeping a log of
everything you do, including the mistakes, will
enable you to recreate the recipe again if it turns
out to be an exceptionally good brew.
Remember, this is an extract brew, much easier
and more forgiving than the traditional all grain
brew, the perfect, “first brew”.

1) Yeast preparation: Remove your yeast from the
refrigerator 1 hour before you start. It's important to
let the yeast warm up gradually to room temperature
before you pitch it into the wort. 4 to 6 hours is ideal.

2) Steeping the specialty grains: Place the
cracked specialty malt grains (such as Crystal Malt,
Chocolate Malt, Roasted Barley etc) in the steeping
bag (mesh or cheesecloth). Fill the boil pot with 3.5
gallons of cold water, and place the bag in the pot in
such a way that it does not touch the bottom. I
generally tie it off to one of the pot handles to keep it
suspended. Heat to 170 degrees Fahrenheit over
medium high heat. Turn off the heat, cover and allow
the grains to steep for another 10 minutes or so.

3) Dissolving the malt extract: After you have
steeped the specialty grains, remove the bag and
allow it to drain into your pot. I use a metal colander
over the top of the pot for this. Do not squeeze the
bag out, as this will release unwanted tannins into
the wort. Throw the steeped grains away or compost
them. While stirring briskly, pour in the malt extract
and mix until dissolved completely. Any undissolved
extract will settle to the bottom of the pot and
possibly burn or caramelize. This is undesirable, as
it will alter the final product quality, possibly for the
worse.

Enhance Your Home Brews
With Brew-Target#, Part Two
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Lactose is a sugar derived from milk. Yeast cannot
convert this type of sugar to ethanol. It is used to
make some cream and stout beers sweet. Now that
we’re done with this first step, let’s see what the
second step has for us.

4) Boiling the wort: You may be tempted to try
bringing the wort (beer without yeast) to a boil over
high heat, thinking as long as you stir constantly to
avoid burning, it will be OK. This is not
recommended, as the chances of a boilover are
substantially increased. It’s best to use medium high.
When the wort starts to boil, reduce the heat a little
to avoid a boil­over. The potential for boil­overs is
high, so find the sweet spot with the heat. After you
are comfortable with the pot boil, add the bittering
hops. Now you may set the timer for the additives.

Note: some recipes call for longer boils and different
timings for hop additions, additives etc., so some
adjustment may be necessary for your particular
recipe. Warning: leaving a boiling pot of wort
unattended is risky, you may return to a substantial
hot sticky mess that your significant other will not

look upon favorably (you will instantly recognise…..
the look), possibly putting the skids on future brews,
not to mention that caramelized malt extract is very,
very, very difficult to clean up! Take it from someone
who knows.

Generally speaking, once is enough to learn your
lesson. At the beginning, the boil coagulates the
proteins into a cruddy sea­foamy kind of floating
crust, which is called the hot break formation. This is
important, so the beer can be relatively clear of
solids in the end product. The cold break, another
important phase for clarifying the beer, happens
later. The hops are weighed on a digital scale before
adding.

5) Adding the hops: In beer, hops add bitterness,
flavor and aroma. The longer a hop is in the boil the
fewer flavors and aromas it will provide as heat
degrades the flavor and floral qualities of hops as
the lupulin oils isomerize into bitterness. Also, the
longer a hop is in the boil the more bitter the beer
will become. Hops added for 60 minutes will produce
only bitterness. Hops added at the last 15 minutes of
the boil will produce a minimal amount of bitterness,
lots of hop flavor and a little aroma. Hops added at
the last 0 to 10 minutes of the boil will add no
bitterness, very little flavor and lots of aroma. Add
your hops according to the times and amounts listed
in the recipe. Be sure to stir in the hops, making sure
they are fully saturated and rolling with the boil.
Hops that are not fully saturated tend to float at the
top and create a thermal blanket, a common cause
of boil overs.

6) Irish Moss: Irish moss is not Irish or moss. Then
what in tarnation is it? It is a seaweed. It helps
coagulate proteins in the wort during the cold break
to further clarify your beer. As a general rule, add the
Irish moss to the last half hour of the boil, if the
recipe calls for it. I have had good results without it,
but for a light steamer beer, or amber ales, it does
make a noticeable difference in the final clarity.

Enhance Your Home Brews With Brew­Target#, Part Two
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7) Gypsum: Gypsum increases the hardness of
water and aids in the clarification process. Gypsum
also helps to accentuate hop profile. Depending on
your local water chemistry, you may or may not need
to add this. I have had undesirable results on each
and every occasion I used this in a DME (dry malt
extract) and LME (liquid malt extract) recipe. Note: In
my opinion, this product is more targeted toward all
grain brewing and Brew­Target# reflects this.

You see, the reason that there are many different
styles of beer originated mostly from water
chemistry. A beer brewer would move to a different
location, brew up a batch of traditional beer, only to
find it was terrible. With experimentation, he would
change different parameters of the recipe until he
found something that would produce a palatable
product. In all grain brewing, (the traditional brewing
method) water hardness and pH could and would
change everything. The first pilsner came about this
way. If memory serves me correctly, the pilsner
fiasco is when they started to examine the water as
the possible cause of traditional recipes working in
one geographical location and not the other. All grain
brewing is an art unto itself and my hat goes off to all
who brew using this method. Step 3 says stop
boiling the wort. Easy enough. So, all knowing
Kenobi, what next? Let us consult Brew­Target# for
step four, shall we?

Now before we get to the wort cooling information
etc, it’s time to discuss, 8) Sanitation: The primary
fermentor needs to be sanitized just prior to using it.
There are many commercial grade sanitizers on the
market for brewing, and they all appear to work well.
I have had excellent results just using pure grain
alcohol (190 proof) on a rag or in a spray bottle and

wiping things down and or soaking them thoroughly.
This is my preferred method and have never had an
infection since I started using it. Chlorine bleach is
not personally recommended but I know it is used by
some brewers.

Sanitation is important especially with beer as the
wort is not usually as acidic (pH of 5.5 ­ 6) as say a
wine must or a whiskey mash, so bacteria tend to
really love the worts. On the other hand, yeast enjoy
a rather acidic environment, with some whiskey
mash and rum wash recipes having a pH clear down
to 3.5. Yeast will compete with the bacteria for the
food in the wort. Yeast double their colony size about
every three hours whereas bacteria will double every
30 minutes or so. Sanitation gives the yeast an edge
in this race. The yeast wins the race by converting
sugars to ethanol and carbon dioxide which kill the
bacteria before they can spoil the wort. It’s important
to sanitise the fermentors. Be sure your fermenter
bucket is food grade quality.

9) Cooling the wort: When the boil is done, it is
time to cool the wort. At a certain temperature the
solids in suspension suddenly cling together and
precipitate to the bottom of the fermentor. This is
known as the cold break. If the wort is too hot it will
kill the yeast. We want a temperature of 68 to 75
degrees (ideal) although I have pitched yeast up to

80 degrees without any problems as long as things
were sanitised properly.

Now we are back to the yeast vs the bacteria race
again. Bacteria love the 90's and really hit the race a
running at those temperatures, but slow down
drastically as temperatures drop, whereas yeast stay
at a good jog from 68 to 78 degrees. Henceforth the
need to give the yeast another advantage by quickly
cooling the wort below 80.

Typically, you can put the pot in the sink or bathtub
with cold water or an ice bath. This works fine for
most home brewers, but it takes a bit longer than I
am comfortable with. There are many wort cooling
gadgets out there too, and they all work fine,
although some are rather expensive. This is how I
do it on a budget. Start the water running in the sink
or wherever you have decided to cool the pot so the
water is as cold as it can be before filling it. Put the
boil pot in the cold water and let it sit for about 15
minutes (next page, top left).

The primary fermenting bucket and a colander
should be ready nearby. If you recall, we are trying
for 5 to 5.5 gallons of beer and we only boiled 3.5
gallons of wort to begin with, so that leaves us with
(minus hop absorption, steeping grains absorption
and evaporation) 2.75 to 3 gallons of boiled wort. We

Enhance Your Home Brews With Brew­Target#, Part Two
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still need three gallons of water. The morning before
brew day, I boil three gallons of water, cover it and
let it cool until evening. Before bed, I put it in the
refrigerator. In the morning of brew day I put it into
the freezer checking occasionally that it's not
freezing. I take this prepared, sanitized, ice cold
water and pour it into the primary fermenter, put the
colander on top of the bucket, and carefully pour the
wort through the colander.

Using a potato masher, I gently press all the liquid I
can out of the hops that are trapped in the colander.

Then, removing the colander, I stir the bucket of wort
fast and furiously for a couple of minutes to aerate.
The purpose of aeration is that when you boil water,
it loses oxygen and the quickest way to get it back is
to stir it hard and frothy. The yeast need this free
oxygen in the beginning of the race. You should now
get a temperature reading of about 68 to 80. We
have successfully completed step four.

This will bring up the subject of 10) Pitching the
yeast. Yeast need free oxygen in the first phase of
their life to grow quickly and multiply. This is called
Yeast Respiration. Be sure that the wort is stirred to
a froth before adding it. If in doubt, do it again. And
again. During the fermenting process, the yeast
quickly use up the available free oxygen and start
looking for another source. That source comes from
the sugar molecule. The yeast break the molecular
bonds of the sugar molecule and harvest the now
free oxygen molecule. That leaves a carbon dioxide
molecule, an ethanol molecule and some others.

When the wort is properly aerated, pour the vial of
yeast into it. If using dry yeast, sprinkle it over the
top of the wort. Now that you have added the yeast,
you have officially made beer. Snap the lid on the
primary, add the airlock (don't forget to put water in
it) and put it in a place where the temperature stays
around 60 to 75.

Step 6, per Brew­Target#.

Final gravity is important in that, if the sugar has all
been used up, then we know the yeast is going
dormant. If you don’t have a hydrometer or
refractometer, you can take a small bit out with a
sterile cup and taste it for sugar. This will not work
very well for a sweet beer. Some brewers I know just
leave it in the primary for a couple of extra days
before racking it to the secondary.

11) Fermentation of your beer: Your ale yeast will
be happier if kept out of the light. A dark shirt or
paper bag wrapped around it will aid in this if you
don't have a dark place for it. Check the airlock after
24 hours to see signs of fermentation (the airlock will
bubble or something … like this).

Enhance Your Home Brews With Brew­Target#, Part Two
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The forces yeast are capable of producing can be
moderately explosive. Fermentation usually takes
around seven to 10 days. After seven days, monitor
the airlock, looking for the bubbles to come about
one a minute or less. When this happens, you are
ready to rack the beer to the secondary fermentor.
It’s pretty simple really, keep it warm, dark and let it
sit. Our final step is step number 7.

12) Secondary fermentor: Carefully siphon off the
beer into the secondary, avoiding sucking up debris
from the bottom of the primary bucket. This is called
“Racking”. Add the airlock to the secondary
fermentor. This stage is for the mild aging and
clarifying of the beer in a clean, oxygen free
environment. This can last from a couple of weeks to
a few months, depending on how clear your beer
needs to be. This is why a glass secondary is
preferred. Some of my primary buckets have a spout
mounted a few inches from the bottom so I can
transfer the beer that way, instead of siphoning, and
they double as bottling buckets. Here are some

pictures of
transferring to the
secondary and a
full secondary
(glass carboy) with
the airlock in place
(left and center
top).

After the aging and
clarifying stage is
done, it’s time to
begin 13) Bottling
your beer. Have
ready at least 48
12 oz, or 33 22 oz

clean sanitized
bottles. The easiest
way to sanitize
bottles is in the
dishwasher, just
don’t use soap. I
usually shake up
some 190 proof in
each bottle. At this
point your beer will
be flat, without
carbonation. To get
the beer
carbonated, we
need to prime it with
some sugar or DME
(dry malt extract). In
a saucepan, bring

one quart of water to a boil, add ¾ cup sugar or 1 ¼
cup of dextrose (corn sugar) or 1 ¼ cup DME. Add 1
teaspoon of lemon juice (lemon juice is optional but
makes for a creamier head). Boil for 10 to 15
minutes. Let cool. Now it's time to rack the beer into
the bottling bucket. When racking from a carboy a
racking cane is very useful.

Remember to suck up about a tablespoon of the
yeast from the bottom of the carboy into the bottling
bucket. Slowly pour the priming sugar into the
bottling bucket while gently stirring to ensure proper
mixing. Using the bottle wand, fill each bottle to
within 1/2 inch of the top and place a sanitized cap
on it to avoid any contamination.

You will notice that when you pull the wand out of
the bottle. it will leave some air at the top. This is
called headspace. When all the bottles are filled,
crimp or snap the caps in place depending on which
style of bottle's you have.

14) Storing your beer: Keep the beer at room
temperature for the first week to ensure proper

Enhance Your Home Brews With Brew­Target#, Part Two
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carbonation. When the first week is over take one
beer and put it into the refrigerator to cool before
serving. If upon opening you hear the telltale pfffft
sound then your beer is properly carbonated. If not,
take each beer and give it a gentle shake once a
day for another week and retry. I have never had a
batch of beer fail the carbonation process.

15) Aging your beer: Beer requires some time in
the bottle to mature, some styles longer than others.
Age your beer in a cool dark place (45 ­ 60). Check
the maturation time in your recipe. When you have
reached the bottle aging minimum, take a beer and
put it into the refrigerator. Taste it to see if it has
matured. You will know if it hasn't. Wait another
week and try again.

Now beer is a funny critter when it comes to
maturing. One day it tastes terrible, and a couple of
days later it is totally awesome. I have experienced
this very phenomenon. When storing your beer for
periods longer than 6 months, it is important to
refrigerate it to prevent spoilage. Beer does not have
enough alcohol content to keep forever. The average
alcohol content of beer is 4.5%. Winemakers know
that an ABV (alcohol by volume) of 12% minimum is
required to ensure long shelf life. Now crack one
open, and enjoy what Brew­Target# has helped you
make with your own hands! One final word of
caution. While sharing your brews with Tux be
advised, after a few he quickly transforms into
SuperTux, ten feet tall and bulletproof, ready to save
the planet from software slavery.

Screenshot ShowcaseScreenshot Showcase
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Enhance Your Home Brews With Brew­Target#, Part Two

http://www.linuxforum.com
http://www.opensource.org/
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by daiashi

About The Game

Teslagrad is a 2D puzzle platformer with action
elements, where magnetism and other
electromagnetic powers are the key to go throughout
the game, and thereby discover the secrets kept in
the long abandoned Tesla Tower. Gain new abilities
to explore a non­linear world with more than 100
beautiful hand­drawn environments, in a steampunk­
inspired vision of old Europe. You play as a young
boy who suddenly finds himself embroiled in a long­
forgotten conspiracy, involving the despotic king who
has ruled the nation with an iron fist for several
years. Jump into an outstanding adventure told
through voiceless storytelling, writing your own part.
Armed with ancient Teslamancer technology and
your own ingenuity and creativity, your path lies
through the decrepit Tesla Tower and beyond.

History

Teslagrad was originally conceived as the world of
Chroma evolved, derived from another casual­
focused multiplayer game called Minute Mayhem.
Rain Games stopped the development of the first

game, on which the team worked together, in order
to focus on Teslagrad, a completely different idea.
After getting some funding and moving to a better
office, Teslagrad development continued.
PlayStation 3 and Wii U versions of the game were
announced on May and June 2013, and a first
playable demo for the PC was released on August
2013. Later that year, Teslagrad attended indie game
events, such as PAX Prime 2013 and Eurogamer
Expo 2013, gathering invaluable feedback and being
warmly received by players and press.

Features

* Complex puzzles! Put your sense of logic to the
test and cleverly manipulate the world around you
using electricity and magnetism.

* Explore! Make your way through rich 2D hand­
drawn surroundings as you journey into ­ and
beyond­ Tesla Tower, picking up use amazing new
items as you go.

* Visual storytelling! Tired of all those words in your
video games? Have no fear, Teslagrad features not
a single snippet of text or squeak of dialogue.
Everything is purely visual, and the entire story is
told through what you see (and sometimes what you
don't see).

* Steampunk powered! Discover a dystopic and
mind­blowing rainy­and­brainy setting, presenting a
steampunk vision of an old Europe­inspired new
world.

* No disruptions! That means no loading screens, no
GUI, no cutscenes. Just the game and you.

* Mesmerizing soundtrack! Awesome mix of classical
orchestra, with a touch of Russian inspiration and a
myriad of metal bits and electrical stuff.

System requirements:

Fully updated PCLinuxOS and Steam

Hardware:

* Minimum:
* OS: PCLinuxOS
* Processor: 2.2 GHz Intel Core 2 Duo
* Memory: 2 GB RAM
* Graphics: Hardware Accelerated Graphics with

dedicated memory
* Hard Drive: 1 GB available space

About The Company

Rain AS is an Indie video game developer based in
Bergen, Norway. Founded in 2010, they are a
relatively young company, growing forth from a
cooperative community of local artists and
programmers.

The games they produce are small, smart, simple
and elegantly designed. Being comprised of people
who all enjoy many different aspects of gaming
allows them to blend these different elements
together until they find something that sticks, all in
the name of creating an enjoyable video game
experience. Everyone on their team is passionate
about gaming, and strive to create games that are
not only fun, but challenging.

Game Zone: TeslaGrad

http://store.steampowered.com/app/249590/
http://rain-games.com/
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Some Gameplay Screenshots

Getting It To Run

Install Steam via Synaptic (if you don’t have it
installed already), then start it. You will need to
create a new account, if you do not already have
one. Once you have Steam up and running, go to
the store tab. Click on the Linux tab if you wish and
search for Teslagrad. Click on and download the
demo. If you have updated your system, including
graphics drivers, you should be good to go.

LinPC.us

It's easier than E=mc2
It's elemental

It's light years ahead
It's a wise choice

It's Radically Simple
It's ...

DOWNLOAD

Mate Desktop

Game Zone: TeslaGrad

http://www.linpc.us
http://www.pclinuxos.com
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